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about us

In 1978 when Winestate Magazine began it was to set the
benchmark for other industry publications to try and match.

Several decades later, many of those other publications have
been and gone while Winestate has remained and is the
leading independent Wine Magazine in Australia.

Going back a over 30 years, Australia had |71 wine and
brandy producers. It was not impossible for a serious taster
to get to know most of them. Today, Australia has more than
1,800 wineries. That's more than ten times as many. This is
why we at Winestate Publishing employ informative quality
journalists and feature columnists who are knowledgeable in
the goings on of each particular wine region. They give our
publications an array of credible and interesting articles on
upcoming events, personality profiles, new and old wineries,
cellar doors and restaurants and other interesting and
informative topics all in an easy to read format.

We have a number of different publications particularly
tailored to suit different market segments:

* Winestate Magazine
* The Wine & Spirit Insider

* Winestate On -line
(Our Consumer Website www.winestate.com.au)

Winestate magazine is a consumer wine buying guide aimed
squarely at those looking to buy wine for their home cellar,
their restaurant or for their bottle/liquor store.

Its primarily focus is on the Australian reader and has a
circulation base of 25,000 with an estimated readership over
100,000. Its readers are influencers within their peer groups
and as such the magazine impacts on a wide-ranging audience.
Particular areas of influence include wine buyers, wine
investment, wine tourism and the restaurant scene.

This magazine is sold and distributed through newsagents and by
subscription to readers across the globe and through selected
liquor retailers across Australia. Winestate’s sales concentration
is in the larger cities and their high-income suburbs.

Regular Sections.

* Grapevine / Dining stories & latest reviews from around
Australia & New Zealand.

* Wine Tutor

* Wine Investment & Collecting

* What's its Worth — Auction Section.

* New Releases

* Varietal Style tastings (eg: Shiraz etc)

* Regional tastings (eg: Barossa, Hunter Valley etc.)

* Wine & Spirit Insider — Beers, Spirits & Value Wine Buys.

* Wine Travel & Tourism

Winestate’s first issue May 978!
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NUMBER ONE
selling magazine in wine & spirit category

Winestate Magazine is distributed in Australia & New Zealand
through Gordon and Gotch. Australia’s largest independent
magazine distributor. Servicing newsagents and newsstands
using their expertise in distribution.

They have the largest range of magazines in Australia, and
provide this service to over 300 publisher clients through
more than 8000 retail outlets. Over 190 million magazines are
distributed into the Australian marketplace each year, which
has a total retail value of over $600 million.

Gordon and Gotch have an extensive database of
approximately 3400 different magazines across a broad range
of categories. Each month their warehouses around Australia
distribute over |7 million magazines.

Winestate for many years has been the number one selling
magazine in the Wine & Spirit category for Gordon & Gotch
on the news stands.

wine & spirit category

Winestate Magazine Ranked Number |
in Wine & Spirit Category

food & wine category

Winestate Magazine Ranked Number 6
in Food & Wine Category

Note from Gordon & Gotch

In relation to the Category info, we have
provided both the main category (Food &
Wine) and the sub category (Wine & Spirits).
You will see notated on each category
where Winestate is ranked in the category.

It should also be pointed out, these are of
course Gordon & Gotch titles only and not
reflective of the entire Australian market.



sponsors events globally

As the world’s biggest buying guide to Australian & New

* I Zealand Wines our aim is to promote those wines that
VI n I ta y achieve the highest results in our tastings.
cAnother love stopy in Verona ) .
People are quite often surprised at the amount of work we do
behind the scenes to not only promote ourselves through the
many wines submitted and published in our magazine, but also

to support & sponsor other exhibitions held around the world.

©
T ; = Over the past few years we have supported events such as
OPWin ef) Wine Australia and been media partners with the Good Food
| & Wine Show and the Adelaide Festival of Arts. Every year we

send one of our team to Vinltaly and showcase a selection of
wines from across Australia and New Zealand at the World's
Largest Wine Show!

Recent sponsorships and media partnerships include the:

Wine & Spirit Asia Singapore
www.foodnhotelasia.com

Hong Kong International Wine & Spirits Fair

www.hktdc.com
Vinitaly
| FHA 2010 | wniadycom
Since 1978 Adelaide Festival

www.adelaidefestival.com.au

@/ Top Wine China
l”g www.topwinechina.com
By supporting these exhibitions and other promotions we believe
A that it is doing our bit to help keep the interest in Australian

& New Zealand wines to the fore and, of course, it helps the
profile of Winestate to be seen at these prestigious events.

~ We are delighted that our magazine reaches these important
NI overseas buyers and that they can use Winestate to help with

their buying decisions including keeping abreast of the new
Hq-m wines coming onto the market.
3 % B
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public tasting events

Winestate is a sponsor of the National Wine Centre and
holds a number of VIP tasting events for our readers as well
as being involved in many charity tastings such as the Alfred
Hospital, Breast Cancer Research, Prostate Cancer and more.
At the same time exposing new wines to people who have
an interest in wine. We were very proud to have had nearly
800 different shiraz wines available for tasting at the World's
Greatest Shiraz Challenge public tasting at the National Wine
Centre in Adelaide each year. This is the biggest tasting of

its kind, with submissions from international producers, with
more entrants from France, New Zealand and South Africa.

At these Winestate Magazine Events we have over 500 wine
buffs in attendance sampling the full range of wines submitted
to our tasting. We do have a number of other events
throughout the year which we have arranged to coincide with
our tastings and have given these events to various charities as
fund raising opportunities. By creating these events it gives us
a further opportunity to promote those wines submitted to
tastings and encourage sampling of brands that many people
have not seen before. Many of the guests on the evenings
busily jot down shopping lists of what to buy when next
purchasing wine.
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added value & promotions for wineries

Point of Sale

Use copies of our Insider for your sales team to set up
promotional displays and prove to retailers that your products
are being promoted.

Third Party Endorsement

Our reputation of calling it how we see it, built up over more
than 3 decades gives your product the street cred and the
independent voice to move recommended products into bars,
restaurants, and liquor stores.

On line Promotions

We can run promotions on-line to add value to your
existing campaign. There are a number of different ways of
integrating our print and online services.

Wine Clubs

We often use surplus wines from our tastings for smaller wine
club tastings again exposing new wines to consumers who may
not have thought of sampling from those varieties or regions.

Advanced Trade Information

We send out our reviews in advance to Liquor retailers so
they can place orders prior to our publications hitting the
newsstands. Our list contains winery contact information so
it is easy for the stores to place orders. This is done usually
6-8 weeks prior to publication.




winestate publishing readership snapshot

: Places of Target Demographic
Readership o .
Distribution Audience Snapshot
Wi Newsagents 759 Male Skewed
ale Skewe
mes’rfﬁe 82,000 Subscriptions Wine Buyers 0
Magazine . . 25 -60 years of age
Wine Club Promotions
Inside Winestate
Wire & Saii Independent liquor stores 57% Mle
Inls?ger Pt 96 000 Chan Liguor Stores Wine Buyes 43% Female
Restaurants 18 — 45 years of age
(Aust, NZ, Singapore,
Hong Kong)
Winestate 94,935 . . 75% Male Skewed
; , Online only Wine Buyers
On-line page views per month 25 -60 years of age
C Tourism offices.
UST(,)m ) Variable on application ~ Point of Sale Wine Buyers Variable on application
Publications .
On-ine
. , Wine Buyers , o
E-Newsletter Can be customised E-mail ' Variable on application
Trade Subscribers
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readership profile

Average price paid for bottle of wine
Less than $10 8%
I'lto $20 44%
Age groups $lltod
Under 25 1% $21 to $50 42%
2510 39 28% More than $50 6%
40 to 54 49%
Total 100%
Over 54 12%
O,
Total |00% How frequently wine consumed
Male/Female Splits Daily 28%
Male 75% )
Several times per week 65%
Female 25%
O,
Total 100% Once per week 2%
Less than once per week 5%
Level of interest in wine
Beginner 9% Total |00%
Casual 25%
Serious 66% Relationship to Wine
Total 100% Consumer 69%
Trade Buyers 22%
Winery 6%
Winestate readers are influencers within Other 3%
their peer groups; as such the magazine
impacts on a wide-ranging audience. Total 100%
Particular areas of influence include wine
buyers, wine investment, wine tourism and :
Type of wine most often consumed
Red wine 52%
White Wine 14%
About the same of each 34%
Total 100%




distribution winestate publishing

Winestate has a national and international circulation
base. Sold at news stands, bookstores, liquor stores and
by subscription, Winestate's sales concentration is in
the larger cities and their high-income suburbs.

Available at news stands in the UK, US, New Zealand,
China, Brazil, Singapore, Taiwan, Hong Kong and more.

Also available in the business lounges of with Qantas,
Virgin Australia, Malaysia Airlines, Singapore Airlines and
South African Airways lounges.

MarketAsia Singapore

Distributes across news stands in Singapore

Winestate Overseas Distribution

H USA BEUR B NZ OASIA E Other

Winestate Distribution by Country Winestate Distribution by Region

ENSW/ACT B VIC B SA/NT oQLb
HUSA BEUR B NZ OASIA B Other B Australia ETAS EWA B Overseas



star rating system

how we

Winestate Rating

e ok ke
*kkk1/2
2.8.2.2.¢
*xx1/2

Kk k

tasting submissions & procedures

compare

Comment

Outstanding
Excellent

Very Good
Good/Very Good

Good

Tasting venues Tastings will be held at Winestate’s Adelaide
office unless otherwise notified. If tastings are to be held
elsewhere, companies will be advised by fax or e-mail of
revised dates and venue details.

Sample Quantities Please supply TWO sample bottles of
each wine. The second bottle will be used should the first
have fault. Prices Please provide RECOMMENDED RETAIL
or cellar door PRICES when submitting, and please indicate
clearly WHICH TASTING the samples are intended for as
well as your CONTACT DETAILS, PHONE, FAX, E-mail and
WEBSITE ADDRESS.

Tax Invoice for entry fee to be included with samples.

Awvailability All submissions must be bottled final blend. All
must be available to the public when the issue is published.

Regional Tastings Any wine, including fortified, is eligible,
provided that it has at least 85 per cent regional fruit content.

Style Tastings 85 per cent of a wine's fruit content must be
varietal for it to be tasted as STYLE; wines less than 85 per
cent varietal will be tasted as BLENDS within the class of
their dominant grape. Where blends of varieties are roughly
equal, please show whether the product should be tasted in a
varietal class, or as a generic blend.

New Release Tastings are open to any style, variety or region.

Submission documents are located at www.winestate.com.au

Wine show Medal ggi;;tt'osr;as'tem 100 Point System
Gold 18.5-20 97 - 100

High Silver 18-18.4 95 - 96

Silver 17-17.9 93 - 94

High Bronze 16.5-16.9 91-92

Bronze 156.5-16.4 89 - 90

Wine judging is an inexact art, not a science - even at the highest levels of proficiency. Accordingly, Winestate uses the star rating
system which reflects arange, rather than a specific point score. Point systems indicate a level of accuracy that simply does not exist.
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tasting & special features 2016

Tosting —— the ying & spirit
Submission

DEADLINE insider

early Junuary  New Releases

Tasting
Submission
DEADLINE

early February

Tasting
Submission
DEADLINE

early February  Fortified Wines

Winestate Magazine
Style Features

Winestate Magazine

Regional Features

Adelaide Hills

Central & Western NSW
Western Australia®
South Africa

early February  Sweet White Wines early January

early January

*Best of the West - PUBLIC TASTING 15th JANUARY 2016

North Island (Wairarapa, Gishorne, Auckland & Northland)
*Wines of South Africa - PUBLIC TASTING 18th JANUARY 2016

Clare Valley early March ~ Cabernet Sauvignon early April — Whiskies early March
Mclaren Vale, Langhome early February & Blends™ of the World
2014 Creek & Fleurieu Bordeaux Blend Varieties,  early March ~ New Releases early April
Jub A Tasmania early February  Merlot, Cab Franc,
UgUSi Malbec, Petit Verdot
Organic Wines
South Island (Nelson, Canterbury) *World Cabernet Challenge VI - PUBLIC TASTING 8th APRIL 2016
Yarra Valley early April  Shiraz/Syrah & Blends* ~ early May  Brandy, Cognac early April
& Southem Victoria Semillon & Blends early April & Amagnac
SEP}BMBER?W Riverland & Riverina early April New Releases early June
ctober (SA, VIC & NSW)
Otago (Central Otago & Woitoki Volle /N4 6 etest iz Syrah Challenge 1 - PUBLIC TASTING 271 Y 2016
Otago NI)
North East Victoria early July — Sparkling Wines early July  New Releases early July
NOVBMB ERZO] 6 | Limestone Coast early July — Pinot Noir early July
/ ecember  Hunter Valley early June
Hawkes Bay (NZ)
Wine of the Year Awards early Dry Riesling, early August ~ New Releases early
SPECIAL Tasfe-off* September  Sauyignon Blanc early August September
- Queensland & Blends,
Ec!mon 21 From the Producer early June  Pinot Gris / Grigio early August
Wine of the Year | 1ogting

*Wine of the Year Awards - PUBLIC TASTING 2nd SEPTEMBER 2016

ANNUAL
best of 2016

January/
February?"

All the four- to five-star wines of
2016 in review.
Re-released in July 2017

See www.winestate.com.au for updates

*Tasting dates and deadlines are subject to change

Wi

Barossa Valley, early Oct 2016 Chardonnay & Blends early Oct 2016  New Releases  early Nov 2016
Eden Valley ltalian & Spanish early Oct 2016

Central & Westem early Nov 2016  Vorietals

Victorig Rosé early Sept ‘16

Marlborough (NZ)

For New Zealand regional tasting submission deadlines, please contact Kay Morganty - kmorganty@winestate.com.au

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
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advertising rates

:A(,:B:]ulf i}::;l;sfmrlﬁzzine Casual 3 x Rate 6 x Rate 9 x Rate 12 x Rate
Double page Spread $18,000 $14,000 $11,000 $10,000 $8900
Full Page $10,000 $8000 $6000 $5500 $4900
Half Page $5900 $5500 $5000 $4700 $2900
Third Page $3300 $3000 $2700 $2500 $1500
Quarter Page $2800 $1600 $1400 $1300 $890
|/8 PAGE CLASSIFIED SECTION | $595 $550 $495 $450 $425
Inside Front Cover $22,000 — Inside Back Cover $1 1,000 — Outside Back Cover $12,000

All rates subject to GST
the wine & SpimmSider Casual 3 x Rate 6 x Rate 9 x Rate 12 x Rate
4 Colour Advertisements
Double page Spread $24,000 $22,000 $19,000 $17,000 $15,000
Full Page $13,300 $11,600 $9900 $9000 $8000
Half Page $7600 $6560 $6600 $5500 $4500
Third Page $4900 $4700 $4400 $4000 $3700
Inside Front Cover $24,000 — Inside Back Cover $12,000 — Outside Back Cover $13,000

All rates subject to GST

Issuance & closing dates

Published last week of the month preceding date of issue. Inserts: Full run only / prices available on application.

Ad bookings close as published schedule.
Refer Booking & Material deadlines Page.

Frequency discount based on advertiser's contract year.

Advertisement composition, art, retouching, typesetting and

No cancellations accepted after closing date. other services as required will be billed to the advertiser.

Agency commission: (conditional on payment being made
within 45 days from receipt of invoice)

Material to be supplied by deadline otherwise publisher
reserves the right to repeat previous advertisement or charge
for space booked.

ONLINE ADVERTISING OPTIONS AVAILABLE WITH
BANNER ADVERTISEMENTS OR LINKS.

Preferred rhp positions 10% loading.

Specific position requests upon application.

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
e-mail sales@winestate.com.au website www.winestate.com.au
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booking & material deadlines

Booking Deadline Material Deadline ON SALE

2016
MAB&EM 12th January 27th January First week of March
2016
MA} June Ist March 8th March Last week of April
JuLyrs .
Ay gust 22nd April 2nd May Last week of June
2016
SEP BM(B) gl‘ 24th June 4th July Last week of August
2016
NOV ,\(I%‘(BeElﬁb or 11th August Ist September Last week of October
SPECIAL
\E\;]iﬁonf 2;)116 . 4th October 19th October First week of December
ine ot the Year
23rd November
ﬁ\NN%}% Si)eciul Mfuierial sizes Last week of Tir
est o please refer to: ast weex or January
Junuury/ 151h November ANNUAL Edition Re-Released July 2017
Februury - arfwork sizes or
www.winestate.com.qu

Winestate Publishing 81 King William Road, Unley 5061 South Australia, phone (08) 8357 9277 fax (08) 8357 9212
e-mail sales@winestate.com.au website www.winestate.com.au
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material requirements

These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print

artwork sizes

Trim size with 5mm bleed FOLD
Double page: 420mm wide x 297mm deep 430mm wide x 307mm deep
<—gutter
Insure type is 15mm from the gutter. Keep all important information 0mm from the top and bottom of your page.
Full page: 210mm wide x 297mm deep 220mm wide x 307mm deep
utter
Insure type is 15mm from the gutter, remember your advertisement could be on a left or right hand page. ¢

Keep all important information |0mm from the top and bottom of the page.

Half page vertical: 90mm wide x 270 mm deep N/A
Half page horizontal: [78mm wide x 135mm deep N/A
Third page vertical: 59mm wide x 270mm deep N/A
Third page horizontal: [78mm wide x 90mm deep N/A
Quarter page square: 90mm wide x |35mm deep

N/A
Quarter page horizontal: | 78mm wide x 68mm deep
|/6 page: 55mm wide x |35mm deep N/A
|/8 page CLASSIFIED: 87mm wide x 65mm deep N/A

the wine&spiritinsider cover specifications

Trim size with 5mm bleed
210mm wide 220mm wide
x 297mm deep x 307mm deep

Insure type is 1 5mm from the gutter. Keep all important information 50mm
from the top of the page and 10mm from the bottom of the page.

supplying images to WINESTATE

When sending images please DO NOT downsize the file
when e-mailing.

If images are too big to e-mail please burn to a CD and post.
v’ RGB JPGs, EPS and Tiff's will be accepted.

X DO NOT supply images in Word files or Power-Point.

73

Allow 50mm from the topi .

to allow for the masthead __ ||

5mm bleed —




WINESTATE,

material requirements

ANNUAL EDITION ONLY

These guidelines for supplying artwork to WINESTATE are designed to ensure our clients get the best possible print
result. If you have any further questions please do not hesitate to call your advertising consultant.

artwork sizes - ANNUAL Edition

Trim size with 5mm bleed F(%l_D

Double page: 488mm wide x 305mm deep 498mm wide x 315mm deep

<—gutter

Insure type is 15mm from the gutter. Keep all important information |0mm from the top and bottom of your page.

Full page: 244mm wide x 305mm deep 254mm wide x 315mm deep

gutter
Insure type is |5mm from the gutter, remember your advertisement could be on a left or right hand page.

Keep all important information |0mm from the top and bottom of the page.

Half page vertical: |02mm wide x 274 mm deep N/A
Half page horizontal: 208mm wide x |37mm deep N/A
Third page vertical: 67mm wide x 274mm deep N/A
Third page horizontal: 208mm wide x 9 mm deep N/A
Quarter page: 02mm wide x |37mm deep

N/A
Quarter page horizontal: 208mm wide x 68mm deep
|/6 page: 68mm wide x 135mm deep N/A
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material requirements

supplying advertisements to WINESTATE

1 File Formats
We prefer files supplied as print ready PDF's. We also accept hi-resolution tiffs and eps files.
Native files must be provided with links and fonts.
If size permits you can e-mail advertisement to: production@winestate.com.au

2 Images
Each image you use should have the following attributes:
|. CMYK color mode
2. 300dpi (dots per inch)
Once the image has been converted to 300dpi and is the size you need it in the advertisement,
in Adobe Photoshop please view it at Actual Pixels (100%) (under View in main menubar).
At any percentage other than |00%, you're probably not seeing a fully accurate view of your image.

3 Flatten artwork and embedded fonts
All artwork should be flattened. Layers in Photoshop should be flattened and ALL transparencies
in InDesign flattened. All fonts must be embedded.

4 Gutter and trim
Make sure type is |5mm from the gutter, remember your advertisement could
be on a left or right hand page.
Keep all important information |Omm from the top and bottom of your page. —»

S Blacks
All black type must be 100% black. For example C=0% , M=0%, Y=0%, K=100% 0
(4 colour black will not be accepted) PAGE GUTTER
Solid blacks should be a rich black. For example C=20% , M=0%, Y=0%, K=100%

6 Hard Copies

Please provide a hard copy colour proof when supplying artwork.

7 Always check your artwork in Adobe Preflight before sending to WINESTATE

See following page for more information.

8 Material to be supplied by deadline otherwise publisher reserves the right to repeat previous
advertisement or charge for space booked.

SPECIFICATIONS - covers

SPINE SPINE
! |
¥ \
INSIDE FRONT INSIDE BACK
TRIM: Width: 210mm TRIM: Width: 210mm
BACK COVER Height: 297mm Height: 297mm
TR':;m‘.jg;;r'n?nmm BLEED: Width: 220mm BLEED: Width: 220mm
gt Height: 307mm Height: 307mm
BLEED:. Width: 220mm *NOTE: |5mm gutter on *NOTE: |5mm gutter on
Height: 307mm right hand side. Please keep left hand side. Please keep
important information away important information away
from this area as it may get from this area as it may get
lost in the fold. lost in the fold.
| |
Smm bleed 5mm bleed GUTTER*
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material requirements

Checking artwork in

Acrobat 7.0 Professional Preflight
This is a MUST before submitting supplied artwork.

1 Open your PDF in Adobe Acrobat 4 Click down on the information icon.
(version 7 shown in example). This will list all the images in pixels per inch and the
colour mode for all images. Please make sure all
2 Advanced (in main menubar) > Preflight images are 300dpi (ppi) and CMYK.

b) Make sure Overprint Preview is ticked

3 Click on “List all Images” > Execute

5  Other things to check:
- List non-embedded fonts > Execute

-« List transparent objects > Execute

76’



material requirements

Creating a PDF from

InDesignCS4

It is important to start the export process with a clean file.

Please make sure the document has been carefully proof
read, all colours are correct, all fonts available and images
are linked properly.

3 Compression

Colour Images > select ‘Bicubic Downsampling to’
from the drop down menu > 300 Pixels per inch
for images above > 450 pixels per inch
Compression > Automatic (JPEG)

Image Quality > Maximum

Greyscale Images > select ‘Bicubic Downsampling to’
from the drop down menu > 300 Pixels per inch
for images above > 450 pixels per inch
Compression > Automatic (JPEG)

Image Quality > Maximum

This can be checked in InDesignCS4: File>Package

Monchrome Images > select ‘Bicubic Downsampling to’
from the drop down menu > 1200 Pixels per inch

for images above > 1800 pixels per inch

Compression > CCITT Group 4

1  File menu > export

2 Saving your Adobe PDF.
Select > Compress Text and Line Art.

Select the location you would like to save your PDF, Select > Crop Image Data to Frames.

create a file name and > save.

2 General
Select 'WINESTATE' from the Adobe PDF Preset drop down menu.
If this is the first time creating a PDF for Winestate, follow all the steps
first and click on ‘Save Preset’ before you click Export.

Select PDF/X-4:2008 from the Standard drop down menu.
Select Acrobat 5 (PDF 1.4) from the Compatibility drop down menu.

4 Marks and Bleeds
Click ‘Al Printer’'s Marks’ will select all marks for the PDF.
Click ‘Use Document Bleed Settings’ should be set at 5mm
around the entire document. FILE > Document Setup > Bleed.
*Only add bleed if you are sending a full page, double page,
or cover advertisements.
If you are sending a 1/6, quarter page, half or third page horizontal
or a half or third page vertical you do not require bleed.
Set Offset to 4mm.
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material requirements

Creating a PDF from

InDesignCS4 con.

5 Output

Colour Conversion should be set to No Colour Conversion.
Inks — The only inks showing should be Process Cyan,
Magenta, Yellow, Black. If you have other colours showing,
you need to go to the Ink Manager button, and check on

the All Spot to Process box.

B Advanced
Job Definition Format should be un-ticked.

7 Security
Does not need to be created.

8 Summary
Make sure nothing issues with creating your PDF under the
Options list.
A B.

- -

9 Save and export PDF
A. If you regularly send artwork to WINESTATE Save Preset.

Next time you can skip all the above steps.

B. Export your PDF after you have gone through all the tabs.

10  Check PDF in Acrobat Preflight > See relevant page
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online

winestate on-line

Our online site is used by wine connoisseurs globally to
research information about the best of Australian wines.

Many of the users of our website are current subscriber to the
magazine or use the site for latest news.

Rankings on most search engines puts it generally in the top
|0 wine sites.

We have consistently maintained an average of | | million hits
per annum on the site.

There is a number of exciting user friendly functions on our
site for wine buyers/consumers to use. These include access
to stories as well as sort functions for wine reviews by region,
variety, winery, vintage & price.

We currently have around 12,000 reviews on this site going
back to 2008. Around 0% are viewed for free with out log
in and an additional 25% can be viewed simply by registering
details (still free) To access the remaining reviews users of the
site can subscribe to a paid subscription.

All the reviews that are viewed for FREE are the reviews in the
magazine with either bottle or label shots supplied alongside
the review. In addition these reviews have the winery website
details and contact e-mail below the actual review.

winestate magazine on-line

* More than | Million page views each vyear.

* Nearly |'| Million Hits each year.

* Over 94,935 page views per month.

* Over 3000 page views per day.

* Over 18,000 unique user sessions per per month.
* Over 216,000 unique user sessions per annum.

* Active database of newsletter subscribers.

www.winestate.com.au

79

www.winestate.com.au - RATE CARD

Sponsored Links on Home Page

*
6 month minimum $500 per month

Links $500 per year*

Premium Links with Logo $1500 per year*

Direct Marketing via our

. P.O.A
Winestate e-newsletter

All rates shown are GST exclsuive

*Can be supplied free of charge if print advertising is purchased.
Contact sales@winestate.com.au for details.

Some Key Points:
* More than | Million page views each year.
* We can run banner advertising.

* Packages for banner ad placement & for links available.



WINESTATE,

digital

Winestate, Australia’s longest running wine magazine, has gone digital with the help of
one of the world's most pre-eminent digital reader companies, Zinio. www.zinio.com

So why are we so excited about Winestate Digital?

Well, because it's a fantastic complement to our print version.

Winestate Digital allows for greater interactivity, so whether
you are perusing our Grapevine section and spot a great
restaurant that you would like to check out, or are searching
our contact details page and want to get a direct link to that
winery, it's all available at the click of a button.

Winestate Digital offers ease of use.

For those with sight impairment or who just want an easier
read, that's not so hard on the ol' peepers, Winestate Digital
has a zoom function that makes it very comfortable.

A search function is also available for when you just can't
remember where you saw that elusive wine or topic of
interest in your current issue.

Winestate subscribers who live overseas no longer have to
wait to get their issue, they'll receive it the same time that
Winestate hits newsstands here!

This makes giving Winestate Digital as a gift for friends and
loved ones a great ideal

Log on to www.winestate.com.au subscribe now!
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